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Slider

1 : These operations will overwrite the previous MIDI Control
settings. If necessary, back up the previous controlMidi file.
2 : When the MIDI channel settings of the host application and the
plug-in software are the same, proper control may not be available.
Please change the MIDI channel setting on either the host
application or the plug-in software.
Please refer to the application's manual for the correct setting.

Manufacturers Product
Name 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 1 2 3 4 5 6 7 8 1 2 3 4 5 6 7 8 HINT

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free OSC BAL RESO CUTOFF EG INT ATTACk DECAY RELEASE IFX BAL Volume Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#8 CC#71 CC#74 CC#79 CC#73 CC#75 CC#72 CC#91 CC#7 C4 D4 E4 F4 G4 A4 B4 C5

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free OSC BAL Free CUTOFF EG INT ATTACK DECAY RELEASE Free Volume Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#8 Off CC#74 CC#79 CC#73 CC#75 CC#72 Off CC#7 C4 D4 E4 F4 G4 A4 B4 C5

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Vector X Vector Y Free Free Free Free Free Free Volume Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#16 CC#17 Off Off Off Off Off Off CC#7 C4 D4 E4 F4 G4 A4 B4 C5

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free
VCO 1
WAVE
FORM

VCO 2
WAVE
FORM

HPF
CUTOFF

LPF
CUTOFF

EG 1
DELAY

EG 1
ATTACK

EG 1
RELEASE Free VCO 1

LEVEL
VCO 2
LEVEL HPF PEAK LPF PEAK EG 2

ATTACK
EG 2

DECAY
EG 2

SUSTAIN
EG 2

RELEASE VOLUME Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#77 CC#82 CC#28 CC#74 CC#24 CC#23 CC#26 Off CC#20 CC#21 CC#29 CC#71 CC#73 CC#75 CC#70 CC#72 CC#7 C4 D4 E4 F4 G4 A4 B4 C5

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free VCO WAVE
FORM

VCO PWM
ADJUST

VCF
CUTOFF

VCF RESO-
NANCE FX MODE FX SPEED PAN Free MG FRE-

QUENCY
MG DELAY

TIME MG LEVEL EG ATTACK EG DECAY EG
SUSTAIN

EG
RELEASE Free VOLUME Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#77 CC#14 CC#74 CC#71 CC#12 CC#93 CC#10 Off CC#27 CC#24 CC#76 CC#73 CC#75 CC#70 CC#72 Off CC#7 C4 D4 E4 F4 G4 A4 B4 C5

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Encoder 1 Encoder 2 Encoder 3 Encoder 4 Encoder 5 Encoder 6 Encoder 7 Encoder 8 Slider 1 Slider 2 Slider 3 Slider 4 Slider 5 Slider 6 Slider 7 Slider 8 Free Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#28 CC#29 CC#30 CC#31 CC#74 CC#71 CC#85 CC#79 CC#77 CC#15 CC#5 CC#20 CC#82 CC#22 CC#18 CC#21 Off C4 D4 E4 F4 G4 A4 B4 C5

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free XMOD INT FREQ MOD PWM INT VCF Cut VCF Reso VCF int Pan Free VCF EG
ATTACK

VCF EG
DECAY

VCF EG
SUSTAIN

VCF EG
RELEASE EG ATTACK EG DECAY EG

SUSTAIN
EG

RELEASE Volume Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#12 #CC13 #CC15 #CC74 #CC71 #CC79 #CC10 Off #CC28 #CC29 #CC30 #CC31 #CC73 #CC75 #CC70 #CC72 #CC7 C4 D4 E4 F4 G4 A4 B4 C5

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free OSC 1
Wave Filter Cutoff Filter

Resonance Filter EG Int F.EG Attack F.EG Decay F.EG
Sustain

LFO 1
Frequency

OSC 1
Control2 OSC 2 Tune OSC 1 Level OSC 2 Level A.EG Attack A.EG Decay A.EG

Sustain
A.EG

Release Volume Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#77 CC#74 CC#71 CC#79 CC#23 CC#24 CC#25 CC#27 CC#15 CC#19 CC#20 CC#21 CC#73 CC#75 CC#70 CC#72 #CC7 C4 D4 E4 F4 G4 A4 B4 C5

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free OSC 1
Wave Filter Cutoff Filter

Resonance
Filter EG 1

Int EG 1 Attack EG 1 Decay EG 1
Sustain

LFO 1
Frequency

OSC 1
Control2 OSC 2 Tune OSC 1 Level OSC 2 Level EG 2 Attack EG 2 Decay EG 2

Sustain
EG 2

Release Volume Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#77 CC#74 CC#71 CC#79 CC#23 CC#24 CC#25 CC#27 CC#15 CC#19 CC#20 CC#21 CC#73 CC#75 CC#70 CC#72 #CC7 C4 D4 E4 F4 G4 A4 B4 C5

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free OSC1 Wave Filter 1 Cut Filter 1
Resonance

Filter 1
Balance EG 1 Int EG 1 Attack EG 1 Decay EG 1

Sustain
OSC 1

Control2
LFO 1

Frequency OSC 2 Tune Amp Level EG 2 Attack EG 2 Decay EG 2
Sustain

EG 2
Release Volume Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#8 CC#74 CC#71 CC#27 CC#79 CC#85 CC#86 CC#87 CC#17 CC#90 CC#21 CC#7 CC#73 CC#75 CC#70 CC#72 #CC7 C4 D4 E4 F4 G4 A4 B4 C5

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free OSC1 Wave Filter 1 Cut Filter 1
Resonance

Filter 1
Balance EG 1 Int EG 1 Attack EG 1 Decay EG 1

Sustain
OSC 1

Control2
LFO 1

Frequency OSC 2 Tune Free EG 2 Attack EG 2 Decay EG 2
Sustain

EG 2
Release Amp Level Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#8 CC#74 CC#71 CC#27 CC#79 CC#85 CC#86 CC#87 CC#17 CC#90 CC#21 Off CC#73 CC#75 CC#70 CC#72 CC#7 C4 D4 E4 F4 G4 A4 B4 C5

1 KLC M1 Le

Click the “KORG” logo. Select “Load Controller Map...” from the
displayed KORG logo menu. Load the controller settings file “M1
Le.cmap” from the “Presets” folder inside the folder where the
KORG Legacy Collection is installed.

0 KLC M1

3

2 KLC
WAVESTATION

PadsSwitches Knobs Sliders

Click the “FILE” button at the bottom of the screen. Click the
“LOAD” button in the display and make the popup menu appear.
Choose “Controller Map ...” from the popup menu.
Load the controller setting file “MonoPoly.cmap” from the “Presets”
folder inside the folder where the KORG Legacy Collection is
installed.

1 ; Connect the KRONOS' MIDI OUT jack to the microKORG's MIDI
IN jack with a MIDI cable.
2 ; Set the microKORG's EDIT SELECT 2 knob to “MIDI”.
Move Knob 1 to set the MIDI CH to “1”. Move Knob 3 to set the
CLOCK to “Ext”.
3 ; Set the EDIT SELECT 2 knob to “GLOBAL”. Move Knob 4 to set
the POSITION to “PrE” (Pre TG).
4 ; Press the 4 button while holding the SHIFT button to enter MIDI
Filter settings. Move Knob 1 to select “P-E” (PROGRAM CHANGE
Enabled). Move Knob 2 to select “C-E” (CONTROL CHANGE
Enabled). Move Knob 3 to select “b-E” (PITCH BEND Enabled).

1 ; Connect the KRONOS' MIDI OUT jack to the MS2000/R's MIDI
IN jack with a MIDI cable.
2; Press the GLOBAL button to enter Global mode. Set “Position”
on the “GLOBAL” page to “Pre TG”.
3; Press the PAGE button to move to the “MIDI” page. Set “MIDI
Ch” to “01” and “Clock” to “External”.
4; Press the PAGE button to move to the “MIDI FILTER” page. Set
“ProgChg” to “ENA”, “CtrlChg” to “ENA”, “P.Bend” to “ENA”,
“NoteRcv” to “ALL”, and “TimbreSelect” to “CC#95”.

1 ; Connect the KRONOS' MIDI OUT jack to the RADIAS' MIDI IN
jack with a MIDI cable.
2 ; Press the GLOBAL button to enter Global mode. Set “Position”
on the “GLOBAL” page to “Pre TG”.
3 ; Press the PAGE button to move to the “MIDI” page. Set “MIDI
Ch” to “01” and “Clock” to “Ext-MIDI”.
4 ; Press the PAGE button to move to the “MIDI FILTER” page. Set
“ProgChg” to “o”, “CtrlChg” to “o”, “P.Bend” to “o”.

1: Connect the KRONOS' MIDI OUT jack to the R3's MIDI IN jack
with a MIDI cable.
2: Turn PAGE SELECT dial to move to “EDIT-P40 Global-A” page
and set KNOB4's “Position” to “Pre TG.”
3: Turn PAGE SELECT dial to move to “EDIT-P42 MIDI” page and
set KNOB1's “MIDI Ch” to “01”, KNOB4's “Clock” to “Ext-MIDI.”
4: Turn PAGE SELECT dial to move to “EDIT-P43 MIDIFilt” page
and set KNOB1's “PROG Chg” to “Enable,” KNOB2's “Ctrl Chg” to
“Enable”, KNOB3's “PitchBend” to “Enable.”

Click the “KORG” logo. Select “Load Controller Map...” from the
displayed KORG logo menu. Load the controller settings file “MS-
20.cmap” from the “Presets” folder inside the folder where the
KORG Legacy Collection is installed.

Click the “KORG” logo. Select “Load Controller Map...” from the
displayed KORG logo menu. Load the controller setting file
“Polysix.cmap” from the “Presets” folder inside the folder where the
KORG Legacy Collection is installed.

Click the controller logo on the “PERFORMANCE” page.
Select “Load Controller Map...” from the displayed controller menu.
Load the controller setting file “LegacyCell.cmap” from the
“Presets” folder inside the folder where the KORG Legacy
Collection is installed.

Click the “KORG” logo. Select “Load Controller Map...” from the
displayed KORG logo menu. Load the controller settings file
“M1.cmap” from the “Presets” folder inside the folder where the
KORG Legacy Collection is installed.
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1 : These operations will overwrite the previous MIDI Control
settings. If necessary, back up the previous controlMidi file.
2 : When the MIDI channel settings of the host application and the
plug-in software are the same, proper control may not be available.
Please change the MIDI channel setting on either the host
application or the plug-in software.
Please refer to the application's manual for the correct setting.

Manufacturers Product
Name 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 1 2 3 4 5 6 7 8 1 2 3 4 5 6 7 8 HINT

PadsSwitches Knobs Sliders

KRONOS External
Setups

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Track 1
Send

Track 2
Send

Track 3
Send

Track 4
Send

Track 5
Send

Track 6
Send

Track 7
Send

Track 8
Send

Track 1
Volume

Track 2
Volume

Track 3
Volume

Track 4
Volume

Track 5
Volume

Track 6
Volume

Track 7
Volume

Track 8
Volume Free Free Free Free Free Free Free Free Free

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Ch:01 Ch:02 Ch:03 Ch:04 Ch:05 Ch:06 Ch:07 Ch:08 Ch:01 Ch:02 Ch:03 Ch:04 Ch:05 Ch:06 Ch:07 Ch:08 Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#18 CC#18 CC#18 CC#18 CC#18 CC#18 CC#18 CC#18 CC#7 CC#7 CC#7 CC#7 CC#7 CC#7 CC#7 CC#7 Off Off Off Off Off Off Off Off Off

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Track 1 Pan Track 2 Pan Track 3 Pan Track 4 Pan Track 5 Pan Track 6 Pan Track 7 Pan Track 8 Pan Track 1
Volume

Track 2
Volume

Track 3
Volume

Track 4
Volume

Track 5
Volume

Track 6
Volume

Track 7
Volume

Track 8
Volume Free Free Free Free Free Free Free Free Free

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Ch:01 Ch:02 Ch:03 Ch:04 Ch:05 Ch:06 Ch:07 Ch:08 Ch:01 Ch:02 Ch:03 Ch:04 Ch:05 Ch:06 Ch:07 Ch:08 Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#10 CC#10 CC#10 CC#10 CC#10 CC#10 CC#10 CC#10 CC#7 CC#7 CC#7 CC#7 CC#7 CC#7 CC#7 CC#7 Off Off Off Off Off Off Off Off Off

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free
Mallet

Stiffness
soft/hard

Mallet Force
strength

Mallet Noise
pitch

Mallet Noise
decay

Fork Tine
Decay

Fork Tine
volume

Fork Tone
Decay

Fork Tone
Volume

Pickup
Geometry
Symmetry

Pickup
Geometry
Distance

Pickup
Volume Input

Pickup
Volume
Output

EQ Low
Gain EQ Mid Gain EQ High

Gain Free Volume Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#44 CC#45 CC#46 CC#47 CC#48 CC#49 CC#50 CC#51 CC#52 CC#53 CC#54 CC#55 CC#56 CC#57 CC#58 Off CC#7 C4 D4 E4 F4 G4 A4 B4 C5

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free OSC1
Detune OSC1 PW FILTER1

Cutoff FILTER1 Q AMP1 Level AMP1 Pan LFO1 Rate LFO1 Delay FILTER1
ENV1 A

FILTER1
ENV1 D

FILTER1
ENV1 S

FILTER1
ENV1 R

AMP
ENV1 A

AMP
ENV1 D

AMP
ENV1 S

AMP
ENV1 R Free Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#44 CC#45 CC#46 CC#47 CC#48 CC#49 CC#50 CC#51 CC#52 CC#53 CC#54 CC#55 CC#56 CC#57 CC#58 CC#59 Off C4 D4 E4 F4 G4 A4 B4 C5

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Chorus Mix Chorus
Depth Chorus Rate Delay Mix Delay Depth Delay Rate Reverb Mix Reverb

Decay

Excitator
Prot (Force,

Mass)

Excitator
Stiff

(Friction)

Excitator
Velocity Filter Cutoff Filter Q EQ Low

Gain EQ Mid Gain EQ High
Gain Free Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#44 CC#45 CC#46 CC#47 CC#48 CC#49 CC#50 CC#51 CC#102 CC#103 CC#104 CC#105 CC#106 CC#107 CC#108 CC#109 Off C4 D4 E4 F4 G4 A4 B4 C5

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Piano Tune Tremoro
Depth

Tremolo
Speed

Drive
amount Effect Depth Reverb mix Volume Free Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#71 CC#70 CC#92 CC#79 CC#16 CC#12 CC#91 CC#19 Off C4 D4 E4 F4 G4 A4 B4 C5

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Keyboard
Glide Filter Cutoff Filter Q Filter Env

Attack
Filter Env
Amount AMP Attack AMP

Release Free AMP Level Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#5 CC#74 CC#71 CC#85 CC#79 CC#73 CC#72 Off CC#7 C4 D4 E4 F4 G4 A4 B4 C5

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Wave Osc 1 Wave Osc 2 Wave Osc 3 Cutoff Emphasis VCF Attack VCF Decay VCF Sustain Level Osc 1 Level Osc 2 Level Osc 3 Level Ext Amount VCA Attack VCA Decay VCA Sustain Free Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#16 CC#17 CC#18 CC#74 CC#71 CC#49 CC#50 CC#51 CC#80 CC#81 CC#82 CC#83 CC#87 CC#88 CC#89 CC#90 Off C4 D4 E4 F4 G4 A4 B4 C5

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Attack Time
Vca 1

Decay Time
Vca 1

Sustain
Level Vca 1

Release
Time Vca 1

Attack Time
Vca 2

Decay Time
Vca 2

Sustain
Level Vca 2

Release
Time Vca 2

HighPass 1
Cutoff

HighPass 1
Resonance

LowPass 1
Cutoff

LowPass 1
Resonance

HighPass 2
Cutoff

HighPass 2
Resonance

LowPass 2
Cutoff

LowPass 2
Resonance Free Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#92 CC#94 CC#95 CC#96 CC#97 CC#98 CC#99 CC#100 CC#65 CC#66 CC#67 CC#68 CC#69 CC#70 CC#72 CC#73 Off C4 D4 E4 F4 G4 A4 B4 C5

Name VCA 1 Filter
On/Off

VCA 2 Filter
On/Off Free Free Free Free Free Free Free Free Free Free Free Free Free Free

Filter 1
Cutoff

Frequency

Filter 1
Resonance

Filter 2
Cutoff

Frequency

Filter 2
Resonance

Filter 3
Cutoff

Frequency

Filter 3
Resonance

VCA
Envelope 1

Gain

VCA
Envelope 2

Gain

125Hz Band
Gain

350Hz Band
Gain

1000Hz
Band Gain

2800Hz
Band Gain

175Hz Band
Gain

500Hz Band
Gain

1400Hz
Band Gain

4000Hz
Band Gain Free Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note CC#104 CC#105 Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#80 CC#16 CC#81 CC#17 CC#82 CC#18 CC#89 CC#90 CC#106 CC#107 CC#108 CC#109 CC#110 CC#111 CC#112 CC#113 Off C4 D4 E4 F4 G4 A4 B4 C5

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free POLTAMEN
TO TIME

DELAY
Dry/Wet

DELAY
time L

DELAY
time R

AUDIO
VCO1

AUDIO
VCO2

AUDIO
VCO3

Encoder 8
AUDIO
NOISE

INT.FIRTER
FRE-

QUENCY

RESO-
NANCE ADSR FILTER

TYPE A D S R Free Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#44 CC#45 CC#46 CC#47 CC#48 CC#49 CC#50 CC#51 CC#52 CC#53 CC#54 CC#55 CC#56 CC#57 CC#58 CC#59 Off C4 D4 E4 F4 G4 A4 B4 C5

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Osc A PW Filter Cutoff Filter
Resonace

Filter Env
Amount Amp Env A Amp Env D Amp Env S Amp Env R Free Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#20 CC#74 CC#71 CC#79 CC#73 CC#75 CC#70 CC#72 Off C4 D4 E4 F4 G4 A4 B4 C5

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Filter Env
Amount Filter Cutoff Filter

Resonace Volume LFO1 Rate LFO2 Rate pad X Pad Y Free Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#69 CC#30 CC#68 CC#83 CC#90 CC#76 CC#16 CC#17 Off C4 D4 E4 F4 G4 A4 B4 C5

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Cut Off Resonance LFO Rate LFO Amt Chorus Delay Free Param 1 Param 2 Param 3 Param 4 Amp Env A Amp Env D Amp Env S Amp Env R Level Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#74 CC#71 CC#90 CC#89 CC#93 CC#91 Off CC#18 CC#19 CC#16 CC#17 CC#73 CC#75 CC#70 CC#72 CC#7 C4 D4 E4 F4 G4 A4 B4 C5

Copy the setting file “controlMidi” into the following folder:
Windows : The “save” folder inside the folder where Prophet V is
installed. (e.g. C:/Program Files/Arturia/ProphetV/save)
Mac : /Library/Preferences/prophetv/save folder This operation will
overwrite the previous MIDI Control settings.
If necessary, back up the previous controlMidi file.

Select “Import...” from the “File” menu and load the setting file
“KORG Midi Links.lx3”.

Copy the setting file “controlMidi” into the following folder:
Windows : The “save” folder inside the folder where CS-80V is
installed. (e.g. C:/Program Files/Arturia/CS-80V/save)
Mac : /Library/Preferences/Cs80V/save folder. This operation will
overwrite the previous MIDI Control settings.
If necessary, back up the previous controlMidi file.

Select “Import...” from the “File” menu and load the setting file
“KORG Midi Links.axf” file.

18

moog
modular V

ARP2600 V

Copy the setting file “controlMidi” into the following folder:
Windows : The “save” folder inside the folder where Moog Modular
V is installed. (e.g. C:/Program Files/Arturia/Moog Modular V/save),
Mac:/Library/Preferences/MoogModularV/save folder This operation
will overwrite the previous MIDI Control settings.
If necessary, back up the previous controlMidi file.

Copy the setting file “controlMidi” into the following folder:
Windows : The “save” folder inside the folder where ARP2600 V is
installed. (e.g. C:/Program Files/Arturia/ARP2600V/save)
Mac : /Library/Preferences/arp2600v/save folder This operation will
overwrite the previous MIDI Control settings.
If necessary, back up the previous controlMidi file.

Copy the setting file “midi.prefs” into the following folder:
Windows : The “save” folder inside the folder where Analog Factory
is installed. (e.g. C:/Program Files/Arturia/Analog Factory/save)
Mac : /Library/Preferences/AnalogFactory/save folder This
operation will overwrite the previous MIDI Control settings.
If necessary, back up the previous controlMidi file.

Select “Import...” from the “File” menu and load the setting file
“KORG Midi Links.sxf” file.

Select “Import...” from the “File” menu and load the setting file
“KORG Midi Links.lls” file.

Select “Import...” from the “File” menu and load the setting file
“KORG Midi Links.uas” file.

Copy the setting file “controlMidi” into the following folder:
Windows : The “save” folder inside the folder where minimoog V is
installed. (e.g. C:Program Files/Arturia/minimoog V/save)
Mac: /Library/Preferences/minimoog V/save folder This operation
will overwrite the previous MIDI Control settings.
If necessary, back up the previous controlMidi file.

Load the “KORG KRONOS template.als” file.
Select “Preferences...” in the “Options” menu (or select
“Preferences...” from the “Live” menu on the Mac) to open the
“Preferences” dialog. Set “Input” of “Remote Control” to
“KRONOS(KEYBOARD)”.

Analog Factory

Ultra Analog VA

String Studio VS

Lounge Lizard
Session

Ultra Analog
Session

minimoog V

CS-80V

Prophet V

Prophet VS

Live
[Send/Volume]

Live
[Pan/Volume]

Lounge
Lizard EP-3

Ableton

Applied Acoustics
Systems

Arturia

24

17

22

11

12

14

15

16

19

20

21

13

23



Master
Slider

1 : These operations will overwrite the previous MIDI Control
settings. If necessary, back up the previous controlMidi file.
2 : When the MIDI channel settings of the host application and the
plug-in software are the same, proper control may not be available.
Please change the MIDI channel setting on either the host
application or the plug-in software.
Please refer to the application's manual for the correct setting.

Manufacturers Product
Name 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 1 2 3 4 5 6 7 8 1 2 3 4 5 6 7 8 HINT

PadsSwitches Knobs Sliders

KRONOS External
Setups

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Pan Free Free Free Free Free Free Free Volume Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#10 Off Off Off Off Off Off Off CC#7 C4 D4 E4 F4 G4 A4 B4 C5

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Direct
Master Level

Overhead
Level Room Level PZM Level Master

Dynamics Free Free Free Master Level Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#16 CC#17 CC#18 CC#19 CC#11 Off Off Off CC#7 B1 D2 F#2 A#2 B2 A2 G2 C#3

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Kick Tune Snr Tune HiH Tune F Tom Tune M Tom Tune H Tom Tune Cym 1 Tune Cym 2 Tune Kick Trim Snr Trim HiH Trim F Tom Trim M Tom Trim H Tom Trim Cym 1 Trim Cym 2 Trim Master Level Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#44 CC#45 CC#46 CC#47 CC#48 CC#49 CC#50 CC#51 CC#52 CC#53 CC#54 CC#55 CC#56 CC#57 CC#58 CC#59 CC#7 B1 D2 F#2 A#2 B2 A2 G2 C#3

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Filter
Frequency Filter Q Filter

Separation
Filter

Amount Vel Attack Vel Release Vel Drive Vel Env2 Volume Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC"74 CC#71 CC#73 CC#52 CC#36 CC#37 CC#38 CC#39 CC#7 C4 D4 E4 F4 G4 A4 B4 C5

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Tone Pitch Amp Env
Attack

Amp Env
Relese Free Free Free Volume Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#74 CC#95 CC#73 CC#72 Off Off Off CC#7 C4 D4 E4 F4 G4 A4 B4 C5

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free VCF Cutoff
Frequency

VCF
Resonance

HPF Cutoff
Freq Q LFO Freq Q ADSR

Attack
ADSR
Decay

ADSR
Sustain

ADSR
Release Free Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#74 CC#71 CC#9 CC#8 CC#75 CC#76 CC#77 CC#78 Off C4 D4 E4 F4 G4 A4 B4 C5

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Filter
Emphasis Filter Cutoff Filter

Contour VCF Attack VCF Decay VCA Attack VCA Decay Free Volume Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#71 CC#74 CC#70 CC#20 CC#21 CC#73 CC#72 Off CC#7 C4 D4 E4 F4 G4 A4 B4 C5

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Master Pan FX1 Pan FX2 Pan FX3 Pan FX4 Pan FX5 Pan FX6 Pan FX7 Pan Master Pan FX1 Volume FX2 Volume FX3 Volume FX4 Volume FX5 Volume FX6 Volume FX7 Volume Free Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#16 CC#17 CC#18 CC#19 CC#48 CC#49 CC#50 CC#51 CC#16 CC#81 CC#82 CC#83 CC#87 CC#88 CC#89 CC#90 Off C5 C#5 D5 D#5 E5 F5 F#5 G5

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Filter Cutoff Filter
Resonance Drive Transpose Fine Tune LFO 1 Rate LFO 2 Rate Part Pan Free Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#74 CC#71 CC#75 CC#76 CC#77 CC#96 CC#97 CC#10 Off C2 C#2 D2 D#2 E2 F2 F#2 G2

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Track 1 Pan Track 2 Pan Track 3 Pan Track 4 Pan Track 5 Pan Track 6 Pan Track 7 Pan Track 8 Pan Track 1
Level

Track 2
Level

Track 3
Level

Track 4
Level

Track 5
Level

Track 6
Level

Track 7
Level

Track 8
Level Free Free Free Free Free Free Free Free Free

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Ch:01 Ch:02 Ch:03 Ch:04 Ch:05 Ch:06 Ch:07 Ch:08 Ch:01 Ch:02 Ch:03 Ch:04 Ch:05 Ch:06 Ch:07 Ch:08 Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#10 CC#10 CC#10 CC#10 CC#10 CC#10 CC#10 CC#10 CC#7 CC#7 CC#7 CC#7 CC#7 CC#7 CC#7 CC#7 Off Off Off Off Off Off Off Off Off

GMEDIA

impOSCar

26

Apple GarageBand

BFD [tune/trim]

For stand-alone operation Windows: Click the “SET UP” button in
the lower right part of the “minimonsta” window to open the menu.
Click on “Input device” and select “KRONOS KEYBOARD”. Mac:
Click the “SET UP” in the lower right part of the “minimonsta”
window to open the menu. Click on “Input device” and select
“CoreMIDI”.

minimonsta

32

Select “Open...” from the “File” menu and open the song file
“DP_KRONOS”.

Image-Line
Software

For stand-alone and plug-in synthesizer operationSelect “MIDI
settings” (located in the “OPTIONS” menu in the upper left corner
of FL STUDIO window), and select “KRONOS KEYBOARD”. Select
“Open” from the “FILE” menu, and load the “KORG KRONOS.flp”
file.

Click the “Load” icon (located in the upper right corner of the BFD
window) to load the “BFD_KORG.bfd” file.

Oddity

M-Tron

FL Studio
[Pan/Volume]

MachFive

Digital
Performer
[Pan/Volume]

BFD [master]

MOTU

Fxpansion

25

30

28

29

31

34

27

33



Master
Slider

1 : These operations will overwrite the previous MIDI Control
settings. If necessary, back up the previous controlMidi file.
2 : When the MIDI channel settings of the host application and the
plug-in software are the same, proper control may not be available.
Please change the MIDI channel setting on either the host
application or the plug-in software.
Please refer to the application's manual for the correct setting.

Manufacturers Product
Name 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 1 2 3 4 5 6 7 8 1 2 3 4 5 6 7 8 HINT

PadsSwitches Knobs Sliders

KRONOS External
Setups

Name
VIBRATO
LOWER
ON/OF

VIBRATO
UPPER
ON/OFF

PERC.
ON/OFF

DRIVE
ON/OFF

ROTATOR
ON/OFF

VELOCITY
ON/OFF Free Free Free Free Free Free Free Free Free Free

PERCUSSI
ON

VOLUME

PERCUSSI
ON DECAY

VIBRATO
MIX

VIBRATO
DEPTH

TUBE AMP
DRIVE

TUBE AMP
BODY

TREBLE
ROTOR
TONE

BASS
ROTOR
TONE

UPPER
MANUAL 16'

UPPER
MANUAL 5

1/3'

UPPER
MANUAL 8'

UPPER
MANUAL 4'

UPPER
MANUAL 2

2/3'

UPPER
MANUAL 2'

UPPER
MANUAL 1

2/3'

UPPER
MANUAL 1' Free Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note CC#30 CC#31 CC#66 CC#67 CC#68 CC#69 Off Off Off Off Off Off Off Off Off Off CC#70 CC#71 CC#73 CC#74 CC#76 CC#78 CC#80 CC#90 CC#12 CC#13 CC#14 CC#15 CC#16 CC#17 CC#18 CC#20 Off C4 D4 E4 F4 G4 A4 B4 C5

Name
VIBRATO
LOWER
ON/OF

VIBRATO
UPPER
ON/OFF

PERC.
ON/OFF

PERC.
Volume

Soft/Normal

PERC.
Decay

Fast/Slow

PERC.
Harmon
Third/

Second

Reveb Type
Studio/
Spring

Rotaor
Dual/ single Free Free Free Free Free Free Free Free

PERCUSSI
ON

VOLUME

PERCUSSI
ON DECAY

VIBRATO
MIX

VIBRATO
DEPTH

Rotator
Slow/Fast Rotaor Run Reverb DRIVE Upper

Drawbar 16'

Upper
Drawbar

5 1/3'

Upper
Drawbar

8'

Upper
Drawbar

4'

Upper
Drawbar
 2 2/3'

Upper
Drawbar

2'

Upper
Drawbar

1 1/3'

Upper
Drawbar

1'
Volume Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note CC#30 CC#31 CC#66 CC#70 CC#71 CC#72 CC#85 CC#67 Off Off Off Off Off Off Off Off CC#70 CC#71 CC#73 CC#74 CC#1 CC#2 C#84 CC#76 CC#12 CC#13 CC#14 CC#15 CC#16 CC#17 CC#19 CC#20 CC#7 C4 D4 E4 F4 G4 A4 B4 C5

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Controller A Controller B Controller C Controller D Controller E Controller F Controller G Controller H Free Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#0 CC#1 CC#2 CC#3 CC#4 CC#5 CC#6 CC#7 Off C2 C#2 D2 D#2 E2 F2 F#2 G2

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free
Sound

Control Knob
1

Sound
Control Knob

2

Sound
Control Knob

3

Sound
Control Knob

4
Pan Free Free Free Volume Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/N
ote Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#20 CC#21 CC#22 CC#23 CC#10 Off Off Off CC#7 C4 D4 E4 F4 G4 A4 B4 C5

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free
Easy Edit

Timbre
Brightness

Easy Edit
Timbre

Harmonic

Easy Edit
Timbre
Detune

Easy Edit
Timbre Env

Amount

Easy Edit
Timbre

Envelope
Attack

Easy Edit
Timbre

Envelope
Decay

Easy Edit
Timbre

Enve-lope
Sustain

Easy Edit
Timbre

Enve-lope
Release

Filter Cutoff Filter 1
Resonance

Filter
Envelope
Amount

Filter 1
Mode

Easy Edit
Volume

Envelope
Attack

Easy Edit
Volume

Envelope
Decay

Easy Edit
Volume

Enve- lope
Sustain

Easy Edit
Volume

Enve-lope
Release

Free Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#102 CC#103 CC#104 CC#105 CC#106 CC#107 CC#108 CC#109 CC#111 CC#112 CC#113 CC#110 CC#114 CC#115 CC#116 CC#117 Off C4 D4 E4 F4 G4 A4 B4 C5

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Timbre
Harmonic

Timbre
Detune

Timbre
Brightness

Timbre Env
Amount

Timbre Env
Attack

Timbre Env
Decay

Timbre Env
Sustain Free LFO Rate LFO Vibrato LFO Timbre LFO

Tremolo
Volume Env

Attack
Volume Env

Decay
Volume Env

Sustain
Volume Env

Release
Master
Volume Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#83 CC#20 CC#74 CC#79 CC#85 CC#86 CC#87 Off CC#90 CC#103 CC#104 CC#105 CC#73 CC#75 CC#70 CC#72 CC#7 C4 D4 E4 F4 G4 A4 B4 C5

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Filter 1
Cutoff

Filter 1
Resonance

Filter 2
Cutoff

Filter 2
Resonance

Env 4 Attack
Time

Env 4 Decay
Time

Env 4 Decay
Level

Env 4
Release

Time
Free Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#74 CC#71 CC#30 CC#68 CC#73 CC#75 CC#70 CC#72 Off C4 D4 E4 F4 G4 A4 B4 C5

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Oscillator A
Pulse Width

Oscillator B
Pulse Width Filter Cutoff Filter

Resonance
Amplifier
Attack

Amplifier
Decay

Amplifier
Sustain

Amplifier
Release Free Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#43 CC#55 CC#70 CC#71 CC#80 CC#81 CC#82 CC#83 Off C4 D4 E4 F4 G4 A4 B4 C5

FM8

41

39

Press the “OPTIONS” button and open the Preference dialog. Set
the MIDI controllers as below.
A:CC#0, B:CC#1, C:CC#2, D;CC#3, E:CC#4, F:CC#5, G:CC#6,
H:CC#7

38 Elektrik Piano

Battery

40

On the “MASTER” page, locate the “CONTROLLER DEFINE”
parameters then press the “LOAD” button for “CONTROLLER
ASSIGN” to load the setup file “KORG KRONOS.f7c”.

On the “MASTER” page, locate the “MIDI Controller Assignment”
parameters then press the “LOAD” button for “CONTROLLER
ASSIGN” to load the setup file “KORG MIDI Assignment.f8c”.

42 PRO-53

1 : Copy the setting file “KORG MIDI Setup.mca” into the following
folder.
Windows: “mca” folder in the folder where the Massive is installed.
(e.g. C:/Program Files/Native Instruments/Massive/mca)
Mac: /Library/Application Support/Native Instruments/Massive/mca
2 : Select “Preference...” in “Massive” menu to open “Massive
Options”. Double-Click “KORG MIDI Setup” in the “Midi Setups” of
“Midi” page to turn it “on”.

Click the “NI” logo. Select “Load Controllermap” in the displayed
menu and load “DefaultMap.txt” from the “Presets”-“Controller
maps” folder inside the folder where PRO-53 is installed.

Press the “OPTIONS” button to open the “Settings” dialog.
Confirm that “USE STD. CC#7 / CC#10 VOLUME & PAN” is active.
In case it is not active, click it.

Massive

B4

B4 Organ II

FM7

Native Instruments

36

37

35



Master
Slider

1 : These operations will overwrite the previous MIDI Control
settings. If necessary, back up the previous controlMidi file.
2 : When the MIDI channel settings of the host application and the
plug-in software are the same, proper control may not be available.
Please change the MIDI channel setting on either the host
application or the plug-in software.
Please refer to the application's manual for the correct setting.

Manufacturers Product
Name 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 1 2 3 4 5 6 7 8 1 2 3 4 5 6 7 8 HINT

PadsSwitches Knobs Sliders

KRONOS External
Setups

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Channel 1
Pan

Channel 2
Pan

Channel 3
Pan

Channel 4
Pan

Channel 5
Pan

Channel 6
Pan

Channel 7
Pan

Channel 8
Pan

Channel 1
Level

Channel 2
Level

Channel 3
Level

Channel 4
Level

Channel 5
Level

Channel 6
Level

Channel 7
Level

Channel 8
Level Free Free Free Free Free Free Free Free Free

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#23 CC#24 CC#25 CC#26 CC#27 CC#28 CC#29 CC#30 CC#8 CC#9 CC#10 CC#12 CC#13 CC#14 CC#15 CC#16 Off Off Off Off Off Off Off Off Off

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Filter Freq Filter Res Filter Mode Filter Env
Amount

Amp Env
Attack

Amp Env
Decay

Amp Env
Sustain

Amp Env
Release Free Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#74 CC#71 CC#76 CC#18 CC#73 CC#9 CC#12 CC#72 Off C4 D4 E4 F4 G4 A4 B4 C5

Name OSC A
on/off

OSC A to
Shaper
on/off

Shaper
on/off

Filter A
on/off

OSC B
on/off

OSC A to
Filter B
on/off

OSC B to
Filter B
on/off

Filter B
on/off Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free OSC A

motion OSC A shift Filter A res Filter A Freq OSC B
motion OSC B shift Filter B res Filter B Freq Free Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note CC#95 CC#61 CC#56 CC#54 CC#41 CC#60 CC#59 CC#75 Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#92 CC#86 CC#78 CC#79 CC#43 CC#44 CC#71 CC#74 Off C4 D4 E4 F4 G4 A4 B4 C5

Name Filter on/off Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Filter Freq Filter Res Filter Mode Filter Env
Attack

Filter Env
Decay

Filter Env
Amount

mp Env
Attack

Amp Env
Decay Free Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note CC#75 Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#74 CC#71 CC#76 CC#14 CC#15 CC#18 CC#73 CC#9 Off C4 D4 E4 F4 G4 A4 B4 C5

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Filter Freq Filter Res Amp Env
Attack

Amp Env
Decay

Amp Env
Release

Mod Env
Decay Free Free Master

Volume Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#74 CC#71 CC#73 CC#9 CC#72 CC#15 Off Off CC#7 C4 D4 E4 F4 G4 A4 B4 C5

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Drum 1 Pan Drum 2 Pan Drum 3 Pan Drum 4 Pan Drum 5 Pan Drum 6 Pan Drum 7 Pan Drum 8 Pan Drum 1
Level

Drum 2
Level

Drum 3
Level

Drum 4
Level

Drum 5
Level

Drum 6
Level

Drum 7
Level

Drum 8
Level Free Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#19 CC#20 CC#21 CC#22 CC#23 CC#24 CC#25 CC#26 CC#8 CC#9 CC#10 CC#12 CC#13 CC#14 CC#15 CC#16 Off C2 C#2 D2 D#2 E2 F2 F#2 G2

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Drum 1 Pitch Drum 2 Pitch Drum 3 Pitch Drum 4 Pitch Drum 5 Pitch Drum 6 Pitch Drum 7 Pitch Drum 8 Pitch Drum 1
Level

Drum 2
Level

Drum 3
Level

Drum 4
Level

Drum 5
Level

Drum 6
Level

Drum 7
Level

Drum 8
Level Free Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#51 CC#52 CC#53 CC#54 CC#55 CC#56 CC#57 CC#58 CC#8 CC#9 CC#10 CC#12 CC#13 CC#14 CC#15 CC#16 Off C2 C#2 D2 D#2 E2 F2 F#2 G2

Name OSC 2
on/off

Ring mod
on/off Noise on/off Filter 1 Link

on/off
Filter 2
on/off

LFO 1
on/off Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free OSC 1

Phase
OSC 2
Phase FM MIX Filter 1 Freq Filter 1

Resonace Filter 2 Freq Filter 2
Resonace Free Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note CC#94 CC#109 CC#81 CC#80 CC#75 CC#30 Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#93 CC#106 CC#108 CC#107 CC#74 CC#71 CC#79 CC#78 Off C4 D4 E4 F4 G4 A4 B4 C5

Name
Layer

Selection
A/B

Layer Link
On/Off

Layer A
Mute

Layer B
Mute Solo Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Layer A Pan Layer A

Level Layer B Pan Layer B
Level Cutoff Resonance Master Filter Master

Resonance Free Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note CC#108 CC#109 CC#106 CC#107 CC#110 Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#83 CC#81 CC#84 CC#82 CC#77 CC#78 CC#74 CC#71 Off C4 D4 E4 F4 G4 A4 B4 C5

Name 24dB Solo Mute START/
STOP REVERSE Free Free Free Free Free Free Free Free Free Free Free FILTER

LFOS RATE

FILTER
LFOS

DEPTH

FILTER
LFOS
WAVE

CHAOS
DOWN/UP

CHAOS
RANGE

POWER
FILTER
MODE

POWER
FILTER
DRIVE

POWER
FILTER
GAIN

CHAOS
PATERN

CHAOS
REPEAT

CHAOS
REVERSE

SAMPLE
START

CHAOS
PITCH

POWER
FILTER

CUTOFF

POWER
FILTER
RESO

POWER
FILTER
WIDTH

Free Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note CC#43 CC#36 CC#37 CC#38 CC#85 Off Off Off Off Off Off Off Off Off Off Off CC#16 CC#17 CC#18 CC#19 CC#48 CC#49 CC#50 CC#51 CC#80 CC#81 CC#82 CC#83 CC#87 CC#88 CC#89 CC#90 Off C4 D4 E4 F4 G4 A4 B4 C5

Name
Layer

Selection
A/B

Layer Link
On/Off

Layer A
Mute

Layer B
Mute Solo Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Layer A Pan Layer A

Level Layer B Pan Layer B
Level Cutoff Resonance Master Filter Master

Resonance Free Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note CC#108 CC#109 CC#106 CC#107 CC#110 Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#83 CC#81 CC#84 CC#82 CC#77 CC#78 CC#74 CC#71 Off C4 D4 E4 F4 G4 A4 B4 C5

43

Dr.Rex

Malstrom

44

Propellerhead

49

48

47

46 NN 19

NN-XT

51

52

Subtractor

ReDrum
[Pitch/Level]

Load the “StylusRMX_KORG.mlt_rmx” as the MIDI Learn set file.

Trilogy53

ReDrum
[Pan/Level]

Atmosphere

Stylus RMX

Reason Mixer
[Pan/Volume]

Spectrasonics

50

45



Master
Slider

1 : These operations will overwrite the previous MIDI Control
settings. If necessary, back up the previous controlMidi file.
2 : When the MIDI channel settings of the host application and the
plug-in software are the same, proper control may not be available.
Please change the MIDI channel setting on either the host
application or the plug-in software.
Please refer to the application's manual for the correct setting.

Manufacturers Product
Name 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 1 2 3 4 5 6 7 8 1 2 3 4 5 6 7 8 HINT

PadsSwitches Knobs Sliders

KRONOS External
Setups

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Audio Pan1 Audio Pan2 Audio Pan3 Audio Pan4 Audio Pan5 Audio Pan6 Audio Pan7 Audio Pan8 Audio Level
1

Audio Level
2

Audio Level
3

Audio Level
4

Audio Level
5

Audio Level
6

Audio Level
7

Audio Level
8 Free Free Free Free Free Free Free Free Free

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Ch:02 Ch:03 Ch:04 Ch:05 Ch:06 Ch:07 Ch:08 Gch Ch:02 Ch:03 Ch:04 Ch:05 Ch:06 Ch:07 Ch:08 Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#10 CC#10 CC#10 CC#10 CC#10 CC#10 CC#10 CC#10 CC#7 CC#7 CC#7 CC#7 CC#7 CC#7 CC#7 CC#7 Off Off Off Off Off Off Off Off Off

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free MIDI Pan1 MIDI Pan2 MIDI Pan3 MIDI Pan4 MIDI Pan5 MIDI Pan6 MIDI Pan7 MIDI Pan8 MIDI Level 1 MIDI Level 2 MIDI Level 3 MIDI Level 4 MIDI Level 5 MIDI Level 6 MIDI Level 7 MIDI Level 8 Free Free Free Free Free Free Free Free Free

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Ch:02 Ch:03 Ch:04 Ch:05 Ch:06 Ch:07 Ch:08 Gch Ch:02 Ch:03 Ch:04 Ch:05 Ch:06 Ch:07 Ch:08 Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#41 CC#41 CC#41 CC#41 CC#41 CC#41 CC#41 CC#41 CC#35 CC#35 CC#35 CC#35 CC#35 CC#35 CC#35 CC#35 Off Off Off Off Off Off Off Off Off

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Oscillator 1
FM Filter Cutoff Filter

Resonance Filter Drive Fitler Env
Attack

Filter Env
Decay

Amp Env
Attack

Amp Env
Decay Free Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#77 CC#74 CC#71 CC#29 CC#37 CC#38 CC#24 CC#25 Off C4 D4 E4 F4 G4 A4 B4 C5

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free OSC1
DEPTH OSC2 PWM OSC2

DEPTH
FX OVER

DRIVE FX DEPTH FX MIX DELAY FBK DELAY MIX Free Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#103 CC#19 CC#105 CC#70 CC#15 CC#93 CC#12 CC#91 Off C4 D4 E4 F4 G4 A4 B4 C5

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free ENV MOD
ATTACK

ENV MOD
RELEASE RES CUTOFF DRIVE LFO MOD

DEPTH
LFO MOD

RATE
LFO MOD

STEPS Free Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#73 CC#72 CC#71 CC#74 CC#70 CC#77 CC#76 CC#82 Off C4 D4 E4 F4 G4 A4 B4 C5

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free OSC1
WAVE OSC1 TONE OSC1

WIDTH
OSC2
WAVE OSC1 TONE OSC1

COARSE
OSC1
WIDTH

MASTER
RELEASE Free Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#9 CC#74 CC#16 CC#14 CC#76 CC#83 CC#18 CC#72 Off C4 D4 E4 F4 G4 A4 B4 C5

Name Kik Mute Snare Mute Tom Mute Hi-Hat Mute Ride Mute Crash Mute Perc 1 Mute Perc 2 Mute Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Kik Volume Snare
Volume Tom Volume Hi-Hat

Volume Ride Volume Crash
Volume

Perc 1
Volume

Perc 2
Volume Free Free Free Free Free Free Free Free Free

Ch Gch Ch:02 Ch:03 Ch:04 Ch:05 Ch:06 Ch:07 Ch:08 Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Ch:01 Ch:02 Ch:03 Ch:04 Ch:05 Ch:06 Ch:07 Ch:08 Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note CC#69 CC#69 CC#69 CC#69 CC#69 CC#69 CC#69 CC#69 Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#73 CC#73 CC#73 CC#73 CC#73 CC#73 CC#73 CC#73 Off Off Off Off Off Off Off Off Off

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free DCF
CUTOFF

DCF RESO-
NANCE

DCF
VELOCITY

DCF ENV.
AMOUNT

DCF
Envelope1 A

DCF
Envelope1 D

DCA ENV.
AMOUNT Free VOLUME Free Free Free Free Free Free Free Free

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#74 CC#71 CC#15 CC#80 CC#83 CC#89 CC#70 Off CC#7 Off Off Off Off Off Off Off Off

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free GM Edit:
cutoff

GM Edit:
resonance

GM Edit: filt
env att

GM Edit: filt
env dec+rel

GM Edit:
amp env att

GM Edit:
amp env dec

GM Edit:
amp env rel Free Volume Free Free Free Free Free Free Free Free

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#74 CC#71 CC#77 CC#78 CC#73 CC#75 CC#72 Off CC#7 Off Off Off Off Off Off Off Off

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Shuffle Dynamics Timing Decay Stereo
Width Presence Low Cut Mic Position Free Free Free Free Free Free Free Free Free

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#76 CC#79 CC#78 CC#75 CC#74 CC#81 CC#80 CC#82 Off Off Off Off Off Off Off Off Off

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Osc 1 Pitch Osc 1 Level Osc 2 Pitch Osc 2 Level Osc 1 P Env Osc 2 P Env Cutoff Resonance Free Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#13 CC#28 CC#22 CC#30 CC#14 CC#23 CC#37 CC#38 Off C4 D4 E4 F4 G4 A4 B4 C5

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free BASIS VCF-
CUTOFF

VCF-
EMPHASIS ENV1>VCF WAVES-

OSC
WAVES-

SUB
ENV1>
WAVES Free VOLUME Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#8 CC#74 CC#71 CC#28 CC#26 CC#27 CC#30 Off CC#7 C4 D4 E4 F4 G4 A4 B4 C5

55

56

First, you need to install the KORG USB-MIDI driver.
1; Select “Device Setup...” from the “Devices” menu and open the
“Device setup” dialog. Select “Generic Remote” from the “Devices”
list in the left column. Select “keyboard” for the “MIDI input” and
press the “Import” button. Load “Cubase_KORG.xmll”. (If you do
not find “Generic Remote” in the left column, please add it using
the “Add/Remove” function.)
2; Press the “Apply” button.

Monologue

A1

54

Cubase MIDI
[Pan/Level]

Cubase Audio
[Pan/Level]

57

58 Tonic

Enable “RECEIVE MIDI CONTROLLER” in “KEY/CONTROL
OPTION” of the “OPTIONS” page.

60 Groove Agent
In the host application, change the MIDI output channel for the
MIDI track you want to use “Groove Agent” on to “ANY” or other
multi-channel outputs.

Embracer

In the host application, change the MIDI output channel for the
MIDI track on which “Attack” is used for each of the sounds that
you want to remote-control such as kick, snare, drum, etc..

62

63 Virtual Guitarist

Hypersonic

Waldorf

65 PPG Wave 2.V

61 HALion

59

64 Attack

Steinberg



Master
Slider

1 : These operations will overwrite the previous MIDI Control
settings. If necessary, back up the previous controlMidi file.
2 : When the MIDI channel settings of the host application and the
plug-in software are the same, proper control may not be available.
Please change the MIDI channel setting on either the host
application or the plug-in software.
Please refer to the application's manual for the correct setting.

Manufacturers Product
Name 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 1 2 3 4 5 6 7 8 1 2 3 4 5 6 7 8 HINT

KRONOS External
Setups

PadsSwitches Knobs Sliders

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Bass Drum Snare Drum Open HH Closed HH Tom2 Tom3 Crach
Cymbal Ride Cymbal

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off C2 G#1 F#4 C4 E2 G2 G5 F7

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Bass Drum Snare Drum Open HH Closed HH Hi Mid Tom Low Mid
Tom

Crach
Cymbal Ride Cymbal

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off B1 E2 A#2 F#2 C3 B2 C#3 D#3

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Timbre 1
Pan

Timbre 2
Pan

Timbre 3
Pan

Timbre 4
Pan

Timbre 5
Pan

Timbre 6
Pan

Timbre 7
Pan

Timbre 8
Pan

Timbre 1
Volume

Timbre 2
Volume

Timbre 3
Volume

Timbre 4
Volume

Timbre 5
Volume

Timbre 6
Volume

Timbre 7
Volume

Timbre 8
Volume Free Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Ch:01 Ch:02 Ch:03 Ch:04 Ch:05 Ch:06 Ch:07 Ch:08 Ch:01 Ch:02 Ch:03 Ch:04 Ch:05 Ch:06 Ch:07 Ch:08 Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#10 CC#10 CC#10 CC#10 CC#10 CC#10 CC#10 CC#10 CC#7 CC#7 CC#7 CC#7 CC#7 CC#7 CC#7 CC#7 Off C4 D4 E4 F4 G4 A4 B4 C5

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Filter Cutoff Filter
Resonance

Master filter
cutoff

Master filter
resonance

Layer one
level

Layer two
level

Amp
Envelope

Attack

Amp
Envelope

Decay
Free Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#77 CC#78 CC#74 CC#71 CC#81 CC#82 CC#73 CC#75 Off C4 D4 E4 F4 G4 A4 B4 C5

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Filter Cutoff Filter
Resonance

Master filter
cut

frequency

Master filter
resonance

Layer A
Level

Layer B
Leve

Amp
Envelope

Attack

Amp
Envelope

Decay
Free Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#77 CC#78 CC#74 CC#71 CC#81 CC#82 CC#73 CC#75 Off C4 D4 E4 F4 G4 A4 B4 C5

Name Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Free Filter Cutoff Filter
Resonance

Master filter
cut

frequency

Master filter
resonance

Layer A
Level

Layer B
Leve

Amp
Envelope

Attack

Amp
Envelope

Decay
Free Note Note Note Note Note Note Note Note

Ch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch Gch

CC#/
Note Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off Off CC#77 CC#78 CC#74 CC#71 CC#81 CC#82 CC#73 CC#75 Off C4 D4 E4 F4 G4 A4 B4 C5

Manufacturer Name
• KORG: These product names are the trademark or a registered trademarks of KORG Inc.
• Ableton: This product name is a trademark or a registered trademark of Ableton AG.
• Applied Acoustics Systems: These product names are the trademark or a registered trademarks of Applied Acoustics Systems DVM Inc.
• Arturia: These product names are the trademark or a registered trademarks of Arturia SA.
• Apple: This product name is a trademark or a registered trademark of Apple Computer, Inc.
• Fxpansion: This product name is a trademark or a registered trademark of FXpansion Audio UK Ltd.
• GMEDIA: These product names are the trademark or a registered trademarks of GMEDIA Music.
• Image-Line Software: This product name is a trademark or a registered trademark of Image-Line Software.
• MOTU: These product names are the trademark or a registered trademarks of Mark of the Unicorn, Inc.
• Native Instruments: These product names are the trademark or a registered trademarks of Native Instruments Software Synthesis GmbH.
• Propellerhead: These product names are the trademark or a registered trademarks of Propellerhead Software AB.
• Spectrasonics: These product names are the trademark or a registered trademarks of Spectrasonics.
• Steinberg: These product names are the trademark or a registered trademarks of Steinberg Media Technologies GmbH
• Waldorf and the Waldorf Logo are registered trademarks of Waldorf Music GmbH Germany.
• ToonTrack: These product names are the trademark or a registered trademarks of Toontrack Music.
• UltimateSoundBank: These product names are the trademark or a registered trademarks of Univers Sons, SA.
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